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File Menu
The File menu provides commands for creating a new configuration, opening an existing 
configuration, saving a configuration, and exiting WaveRave 1.5.

New Create a new, untitled, .WAV configuration.
Open Open an existing .WAV configuration.
Close Close the current .WAV configuration.
Save Save the current configuration if its contents have changed.
Save As Save the current configuration under a new name.
Exit Exit WaveRave 1.5.



Exiting WaveRave

To exit WaveRave 1.5, choose File|Exit from the menu.



File Close Command

File|Close will close the currently active .WAV configuration.    If you have made changes to
it, WaveRave 1.5 will ask you if you wish to save the changes.



File New Command

The File|New command opens a new, untitled .WAV configuration, and makes it the active 
configuration.    WaveRave 1.5 prompts you to name untitled configurations when they are
closed.

If you have made changes to the configuration currently open at the time of selecting File|
New, then WaveRave 1.5 will ask you if you wish to save your changes first, before 
closing the configuration and beginning a new one.

If you do not have any configuration open at the time of selection, WaveRave 1.5 will gray
the File|New option, and will not allow you to select it.



File Open Command

The File|Open command displays the Open a File dialog box so you can select a 
configuration file (*.RAV) to load into WaveRave 1.5.



File Save Command

The File|Save command saves the currently active .WAV configuration to disk.    If the 
configuration is unnamed, the Save File As dialog box is displayed so you can name the 
file, and choose where it is to be saved.



File Save As Command

The File|Save As command allows you to save the current .WAV configuration under an 
new name, or in a new location on disk.    The command displays the Save File As dialog 
box.    You can enter the new file name, including the drive and directory.    If you choose an 
existing file name, you are asked if you want to overwrite the existing file.



Edit Menu
The Edit menu provides commands to

Add
Delete
Change
Colorize
Show Notes
Options



Playing Wave Files (.WAV)
To play a wave file press a button with a wave file assigned to it and it will play.    You will 
notice that the .WAV file will play instantly.    Even off of CD-ROMs and network drives, or 
floppies, the access time is very fast.



Status lights

The green LED is used to show that a button has focus, or selection status. The currently 
selected button is used for the Edit menu items Add, Delete, Change, Colorize, and 
Show Notes.

The red LED is used to show that the button is currently playing the assigned .WAV file.    
The red LED will turn off when it is done playing the sound.



What does WaveRave 1.5 do?
WaveRave 1.5 is a .WAV player, that allows you to assign .WAV files to individual buttons
for quick replay.    WaveRave 1.5 will play each file instantly, with no delay caused by 
loading the file information into memory.    Therefor, you are only limited by disk space in 
how long of a .WAV file you select to play.    Most other .WAV players have limits in this area.

Example Uses of WaveRave 1.5



About .WAV files
A .WAV file is a digital representation of sound.    This digital representation is done in the 
same manner as an Audio Compact Disk player.    The sound is sampled and converted to a 
value (usually 8 or 16 bits in size).    This value is then stored in the .WAV file.    
To play the .WAV file, the stored value is sent out through hardware (i.e., the sound card) 
that modulates the sound card with the digital value and recreates an approximation of the 
original sound.
The .WAV file is stored in the RIFF format.    This format can have many pieces of 
information, such as the sample rate and number of channels, the digital data of the wave 
file. etc.    Other information can include the Artist, Copyright, Comment and Engineer.    
High quality .WAV files and .WAV players will support reading this set of additional 
information from the RIFF file.



Drag/Drop from the File Manager

A file or a group of files can be opened into WaveRave 1.5 by dragging the selected file or
files from the File Manager, and dropping it/them on the WaveRave 1.5 Main Matrix 
Window (which contains all the buttons).

What is Drag and Drop
How to use Drag and Drop



What is Drag and Drop
Drag and drop is a method of selecting files from a file name server (the Windows File 
Manager is one such server) and then dragging the files as an icon to a client program. 
WaveRave 1.5 is a client program that will accept wave files and then add them to next 
available button(s).



How to use Drag and Drop
Select a single file or group of wave files in the file manager.    Using the left mouse button, 
click and hold on one of the selected files icon (next to the file name on the left). Now drag 
the icon to WaveRave and release the left mouse button. The files will be added to the 
available buttons.



The Play Button Menu

This is the right mouse button menu, brought up by clicking on a WaveRave 1.5 button 
with the Right Mouse Button.

Add
Delete
Change
Colorize



Example Uses of WaveRave
Sound collectors who scour Online services or collect WAVE files on CD-ROMs find 
WaveRave 1.5 useful for sorting through large groups of files to locate a certain sound.    
For WAVE file creators, the ability of WaveRave 1.5 to group sounds provides an excellent 
test and debug environment.    WaveRave 1.5 can be used as a virtual cart machine for 
radio broadcasting, and a sample commercial is included in the program to demonstrate 
this use.    We have heard from broadcasters using it live in the studio in their laptop.    
Weve seen it used as a sound-effects unit.    And using it to browse large numbers of WAVE 
files has been a regular use by most WaveRave 1.5 users.



What is Planned for Version 2.0?
We are planning to add a whole list of great new features.    These include:

1.    DDE Server.    Access sounds from other programs.
2.    Full support of Universal Naming Conventions
3.    The ability to record new sound .WAV files for a button.
4.    VU Meters
5.    Play position indicator (so you can see how far into the .WAV you are).
6.    On-the-fly mixing.    Play several .WAVs at the same time.
7.    Digital Filtering (DSP).
8.    Note Bar.    Display notes about a .WAV file (i.e., last few words in an Ad, etc.).
9.    Type 2 .WAV support.    This is a new, cutting edge method of sound 

representation.
10.    Edit .WAV notes.    Things like copyrights, etc. can be added into a .WAV file.

All this and more will be available in version 2.0.    Support WaveRave 1.5 and you will 
have the best in .WAV tools.



DSP
DSP stands for Digital Signal Processing.    This is a method of using software to manipulate 
signals to shape them.    This includes equalization, filters, and other effects.



Universal Naming Conventions
This allows you to access network resources without assigning them to a Drive letter.    
I.e., \\main_server\work as opposed to sharing \work as F:.



DDE Server
A DDE Server is a program which interfaces using the Dynamic Data Exchange protocol 
with other programs.    This allows the sharing of resources and information between many 
types of programs.



Technical Support
First, you must be a registered user of WaveRave 1.5 to receive technical support, unless 
you need help with the installation process.

Technical support for registered users is free.    You can call Monday through Friday, except 
on holidays, between 9:00 AM and 6:00 PM.    Please have your registration number ready, 
as well as a good description of the problem.

You may also send mail to us through CompuServe, 71514,3336, or 71664,3726.

Call Rusty and Edies BBS, 1-216-726-3636 with your modem and terminal software, and 
leave e-mail to Tomas Hood.

Or call the Support BBS, 1-206-493-6881, and log on with your First and Last name as 
shown in the registration information, and use your Access Number as your password.

Thank you for registering!

Registration Information



Assigning a .WAV file to a button
The easiest way to assign a wave file to a button is to use the EDIT|ADD menu item or just 
press the Insert key.
At this point you can type in the full path name of the wave file or click the Browse button.
Once a wave file name is correctly entered, you can press the Test button to listen to the 
wave file before you add it to the button list.    If this is the file you want then press the OK 
button.    This will assign the wave file to the next available button.



The Options Dialog
The options dialog allows you to change the grid size, by selecting how many columns and 
rows you want.    Selecting a column size of 3 and a row size of 3, for instance, gives you 9 
buttons.
Also, you may select whether or not WaveRave 1.5 will give you audio prompts.



Show Notes Dialog
The Show Notes Dialog displays information that can be stored internally in the .WAV files.   
These notes may include the artists name, the legal copyright, the engineers that worked 
on the .WAV file and any other type of comments.    More and more .WAV files will support 
this.



The Registration Dialog
After you have paid your registration and receive your registration key, you will use this 
dialog to fill in your name (exactly as you gave it to us for registration), the serial number
(which you will receive from us) and the access key (which you will also receive from us). 
Thats it!    Once this is done correctly, you will have a fully registered WaveRave!



Delete
This allows you to remove a .WAV file from a button.



Change
This allows you to change the .WAV file from what it is currently, to a new one of your 
choice.



Colorize
This feature makes button identification easier.    By coloring groups of buttons according to 
type or other criteria of your choice, you can quickly identify them.    This option allows you 
to pick from all legal colors available to you on your machine under Windows.



About Shareware
Shareware can be defined as a try before you buy market.    Over the past years, 
shareware has grown from an out-of-the-basement market to a large and very reliable 
software distribution method.    It provides users with high quality software at an affordable 
price.    However, to continue this effort, software authors must be supported.    Also, the 
software is copyrighted and can not be used legally after the trial period.    Use after the 
trial period requires registration.
WaveRave 1.5 is a shareware product. WaveRave 1.5 must be registered after the trial 
evaluation period.
Copyright laws apply to shareware software products, and the copyright holder retains all 
rights, with a few specific exceptions as stated in the license and copyright section of the 
software.    WaveRave 1.5 software includes the executable, the help file(s), and other 
related collections of information (see Copyright and License).    The author specifically 
grants the right to copy and distribute the software, either to all or to a specific group.    For 
example, some authors require written permission before a commercial disk vendor may 
copy their shareware products.    Refer to the Copyright and License section for a complete 
copy of the WaveRave 1.5 copyright and license agreement.
Shareware is a distribution method, not a type of software.    You should find software that 
suits your needs and pocketbook, whether it is commercial or shareware.    The shareware 
system makes fitting your needs easier, because you can try before you buy.    And because
the overhead is low, prices are low also.    Shareware has the ultimate money-back 
guarantee -- if you do not use the product, you do not pay for it.    Therefor, if you enjoy 
using WaveRave 1.5, and wish to continue using it after the trial period, you must register
it.

How to Register
A good idea!

Copyright and License
Important Information that you need to read.



How to Register WaveRave
New WaveRave 1.5 users can register for $25.    The next version, WaveRave 2.0, is a 
$45 product.    Registered users of WaveRave 1.5 will be able to upgrade to version 2.0 for
$10.    Upgrade from WaveRave 1.5 to WaveRave Pro is also available.
You may register WaveRave 1.5 by one of these methods:

1.    Call our ORDERS ONLY HOTLINE.    1-800-270-4WDC    (1-800-270-4932).    
Someone is able to take your Visa or MasterCard only between the hours of 9 AM and 6 
PM, Pacific Time, Monday through Friday, Except holidays.    Of course, you may also call 
this hotline at 1-206-493-6882.    And, you may call outside the hours of 9 AM to 6 PM, 
but you will only be able to leave a message.
Be prepared to give us your Visa or MasterCard number, along with the card Expiration 
Date.    We will bill your account at the time of registration.    Charges will be made by 
Westmarch Development Company, and will appear on your bill as such.
2.    You may also register through an on-line service:

CompuServe
GO SWREG.    Keyword is WaveRave.    The cost is $30 USD.    This is slightly 
higher than the other options, due to costs incurred through using 
CompuServe Software Registration.

Crystal Mountain BBS
At the Name prompt, enter WaveRave Shareware.    For your password, type
Register.    This will bring you to a menu in which you will be able to enter 
your subscription information.

3.    Mail
You may mail your registration to Westmarch Development Corporation.    
Expect delays of two to four weeks to receive your registration in return mail.   
Mail the following form to Westmarch Development Corporation, WR 
Registration, 4820 Yelm Hwy SE, Suite B-199, Lacey, Washington 
USA, 98503.    Enclose a money order or Visa or MasterCard information 
(number and expiration date).

The Registration Form

What do I get when I register?
Once you register WaveRave 1.5, you will be entitled to:

1.    Free tech support between 9:00am and 5:00pm Pacific time, by calling 1-206-493-
6882; or by leaving mail at Rusty and Edies BBS, 1-216-726-3636 (addressed to Tomas
Hood), or via the Online bbs (see item 4 below),

2.    Automatic notification of any major program updates;
3.    Additional program updates at a significantly reduced rate;
4.    24-hour access to the Registered Users BBS at Westmarch Development Corporation.

a.    Call the Crystal Mountain BBS, 1-206-493-6881 (V.32bis/HST)    (Fido 1:352/777)
b.    Access the Westmarch Support Sub-Board by entering your First and Last name 
as entered in the registration, and your access number as your password.



The Register Dialog
How to enter your registration information once you have registered.

Copyright and License
Important Information that you need to read.



About WaveRave
WaveRave 1.5 is a multimedia sound tool which functions much like a professional audio 
sampler.    Listening to large numbers of multimedia sounds with conventional sound tools 
can be a tedious task, but using the Westmarch team's breakthrough technology, 
WaveRave 1.5, allows as many as 144 sound files to be loaded simultaneously.    Playback 
is as instantaneous and simple as a mouse click. WaveRave 1.5 brings this professional 
playing and sampling capability to the PC.
WaveRave 1.5 plays files with names having an extension of .WAV.    These are called 
WAVE files.    WaveRave 1.5 comes with many features that make it more powerful than 
other Wave File players.    WaveRave 1.5 supports the RIFF file standard and allows the 
you to view the extra information in wave files.    It also has an intuitive user interface and 
allows you to play many Wave Files in sequence for sound effects.
You can assign each sound to it's own virtual button on the screen.    Playback is 
accomplished using a mouse to point and click the button.    Buttons can have a color tag 
for instant recognition, and labels provide positive identification of the sounds.    You can 
also create, load and store groups of sounds.    Green and red LEDs indicate which button is 
selected and playing. WaveRave 1.5 can create just a few of these special buttons or fill 
the screen, at your option.

Copyright and License
Important Information that you need to read.



About Westmarch Development Corporation
Westmarch Development Corporation is located in the scenic Western state of Washington.  
Situated in Olympia, in the southern part of Puget Sound, Westmarch creates quality 
software products (such as WaveRave 1.5) for the Windows platform.    Westmarch is 
dedicated to a standard of programming that translates into products which are high in 
value.    Yet, Westmarch provides these products at economical prices.    WaveRave 1.5 is 
one such product, released through the shareware method of software distribution.
Westmarch Development Corporation is available for certain types of custom application 
development.    If you would like to explore the idea of contracting Westmarch, please fax or
write:

Westmarch Development Corporation
4820 Yelm Hwy. SE
Suite B-199
Lacey, Washington    USA    98503

Fax:    1-206-459-7384



Copyright and License Information
DISCLAIMER
Users of WaveRave 1.5 must accept this disclaimer of warranty:

WaveRave 1.5 is supplied as is.    Westmarch Development Corporation disclaims all 
warranties, expressed or implied, including, without limitation, the warranties of 
merchantability and of fitness for any purpose.    Westmarch Development Corporation 
assumes no liability for damages, direct or consequential, which may result from the use of 
WaveRave 1.5.

COPYRIGHT
WaveRave 1.5 and the associated files (the WaveRave 1.5 Package) is copyright, 1994, 
by Westmarch Development Corporation.    All rights reserved.

LICENSE
WaveRave 1.5 Package Definition
The WaveRave 1.5 Package is defined as containing all the material listed in Contents of
Distribution Set, in the README.1ST file.

Definition Of Registration
Registration is defined as the payment of a designated fee by you to Westmarch 
Development Corporation for license to continue using the WaveRave 1.5 Package beyond
the term of the evaluation period.    Registration fees are set solely at the discretion of 
Westmarch Development Corporation.

Applicable Law
This software and accompanying documentation (the WaveRave 1.5 Package) are 
protected by United States Copyright law and also by International Treaty provisions.    Any 
use of this software in violation of Copyright law or the terms of this limited license will be 
prosecuted to the best of our ability.

Evaluation Term
You may use the WaveRave 1.5 Package for evaluation purposes for a period not to 
exceed twenty (20) days.    If you continue using all or any part of the WaveRave 1.5 
Package after the twenty (20) day evaluation period, you MUST pay Westmarch 
Development Corporation the correct registration fee.

If you do not Register the WaveRave 1.5 Package you MAY NOT use it beyond the twenty 
(20) day evaluation period.    If you do so you are violating the terms of this license, US 
Copyright Law, and the applicable International Treaty Provisions.

Distribution
As the exclusive copyright holder for WaveRave 1.5, Westmarch Development Corporation
authorizes distribution only in accordance with the following restrictions.



Individuals are hereby granted permission by Westmarch Development Corporation to copy
the WaveRave 1.5 Package for their own use, for evaluation purposes, or for other 
individuals to evaluate, ONLY when the conditions below (see Conditions) are met.

Conditions
The WaveRave 1.5 Package - including all related program files and documentation files - 
CANNOT be modified in any way, by addition or deletion, and must be distributed as a 
complete package, without exception.
No price or other compensation may be charged for the WaveRave 1.5 Package.    A 
distribution fee may be charged for the cost of the diskette, shipping and handling, as long 
as the total (per disk) does not exceed US$8.00 in the US and Canada, or US$12.00 
internationally.

Termination
This license expires after twenty (20) from your first installation and use of the WaveRave 
1.5 Package.
If you violate any provisions of this license, it is automatically terminated.
If you do not register the WaveRave 1.5 package by the time the twenty (20) day 
evaluation period is expired, you MUST delete all of the WaveRave 1.5 Package files from 
your storage unit of each and every machine on which you have it installed for running.

Rights Reserved
All rights not expressly granted here are reserved to Westmarch Development Corporation.

How to Register
A good idea!



The Registration Form
 (use the Print option under the File menu above)

_____________________________________________________________________
Registration FORM - Registration FORM

_____________________________________________________________________

Name ___________________________________________________________

Address _________________________________________________________

City _____________________________________________________________

State_____________                      ZIP______________    

Country (leave blank if U.S.A.)_______________________________________

Daytime Phone _(_____)_______________________EXT__________________

Credit Card (Visa/MasterCard) _______________________________________

Expiration Date:____________________________________________________

Signature:_________________________________________________________

Registration........    $ 25.00

Quantity........ _______

Applicable Sales Tax (WA) _______

Total Enclosed or Charged _______

Please note that foreign orders must be paid in U.S. Dollars.

Fill out the section below so it can be used as a mailing label
---------------------------------------------------------------------------------------------------------------

----

MAIL TO:



---------------------------------------------------------------------------------------------------------------
--------

Comments or questions:

---------------------------------------------------------------------------------------------------------------
--------
(----end of registration form----)



Windows Keys
Cursor Movement Keys
Editing Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



Cursor Movement Keys

Key(s) Function

Arrow key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or Ctrl+Left Arrow Moves to the beginning of a field.
Pape Up or Page Down Moves up or down in a field, one screen at a time.



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
Or, deletes selected text.



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type, when a menu has focus.
Alt+Letter key Pulls down the menu whose underlined letter matches the one 

you type.
Left or Right Arrow Moves among menus of the main menu bar.
Up or Down Arrow Moves among menu items within a drop-down menu.
Enter Chooses the selected menu item.



System Keys

The following keys can be used from any window, regardless of the application you are 
using.
Key(s) Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+Tab Switches to the next application window, restoring applications 

that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.



Text Selection Keys

Key(s) Function

Shift+Left or Right Arrow Selects text one character at a time to the left 
or right.

Shift+Down or Up Selects one line of text up or down.
Shift+End Selects text to the end of the line.
Shift+Home Selects text to the beginning of the line.
Shift+Page Down Selects text down one window.

Or, cancels the selection if the next window is 
already selected.

Shift+Page Up Selects text up one window.
Or, cancels the selection if the previous 
window is already selected.

Ctrl+Shift+Left or Right Arrow Selects text to the next or previous word.
Ctrl+Shift+Up or Down Arrow Selects text to the beginning (Up Arrow) or end

(Down Arrow) of the paragraph.
Ctrl+Shift+End Selects text to the end of the document.
Ctrl+Shift+Home Selects text to the beginning of the document.



Window Keys

Key(s) Function

Alt+Spacebar Opens the Control menu for an application window.
Alt+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+Tab Switches to the next application window, restoring applications 

that are running as icons.
Alt+Enter Switches a non-Windows application between running in a 

window and running full screen.
Arrow key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.






